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= KORG _multi/poly &

Specifications

« Product: multi/poly Analog Modeling Synthesizer
« Software Version: 1.0.2 or later
« Operating Systems:
o MacOS: Mac OSX 10.12 through macOS 15, Intel or Apple Silicon

o Windows: Windows 10 and 11, 64-bit versions only. Touch panel operation is not supported.

Product Usage Instructions
Installation
To install the multi/poly software version 1.0.2 or later:

Check the software version of the multi/poly:

1. Press UTILITY and then SHIFT + < (PAGE -).

This will take you to the About page. The version number is shown at the top of the screen. If the version is below
1.0.2 you'll need to update the multi/poly before continuing. The latest multi/poly software can be installed via the
Korg System Updater, downloaded from the Korg website (http:/www.korg.com/ ).

What'’s installed on my computer, and why?

The Editor/Librarian communicates with the multi/poly using networking over USB, as opposed to MIDI. To
automatically identify and connect with the multi/poly over the network, the Editor/Librarian uses the mDNS
standard. On Windows, this requires Apple Inc.’s Bonjour, and so this is installed along with the Editor/Librarian
application.

USB Network must be set to NCM
To use the Editor/Librarian, the multi/poly’s USB Network parameter must be set to NCM.

To make sure that this is set correctly:


http://www.korg.com/

1. Press UTILITY twice, and then hold SHIFT and press > (PAGE +).
This takes you to the MIDI & USB page, as shown below.
2. Make sure that USB Network is set to NCM.

3. If you had to change this from RNDIS to NCM, turn off and restart the instrument before proceeding.
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« RNDIS: This is the legacy RNDIS protocol, which is no longer supported by the Editor/Librarian.
« NCM: This is the Network Control Model protocol, for use with MacOS and Windows 10 and later.

Important: Changes to this parameter take effect only after the multi/poly has been turned off and restarted.

MacOS

To install the software on MacOS:

1. On the multi/poly, make sure that the USB Network parameter is set to NCM.
For more information, see “USB Network must be set to NCM” on page 4.
2. Connect your multi/poly to the computer via USB.
3. Open the multi/poly Editor/Librarian [version number] .dmg file in the Finder.
The disk image will open.
4. On the disk image, open the multi/poly Editor/Librarian [version number] .pkg file.
The installer will start.
5. Follow the on-screen instructions to complete the installation. Enter your administrator password when

prompted.

The installation will run, and the Editor/Librarian application will be installed in Applications/KORG/multi/poly.

Windows

To install the software on Windows 10 or later (earlier versions are not supported):

1. On the multi/poly, make sure that the USB Network parameter is set to NCM.
For more information, see “USB Network must be set to NCM” on page 4.

2. Double click “Korg multi/poly Editor/Librarian [version number] Installer.exe.”



The installer will start.
3. Follow the on screen instructions to complete the installation.
The installation will run, including the Editor/Librarian application, Apple Inc.’s Bonjour, and NCM networking
support (using standard Windows drivers).
4. Connect your multi/poly to the computer via USB.
In some cases, the multi/polys may not be immediately recognized after installation. If this occurs, simply restart

your computer.

Operating Requirements

To use the multi/poly Editor/Librarian:

« Ensure your multi/poly is running software version 1.0.2 or later.

« You need a USB cable and a USB-capable Mac or Windows computer that meets the specified requirements.

Note: Full functionality is not necessarily guaranteed with all computers, even if they satisfy these system
requirements.

MacOS
Mac OSX 10.12 through macOS 15, Intel or Apple Silicon.

Windows
Windows 10 and 11, 64-bit versions only. Touch panel operation is not supported.

USB Network Configuration

To set up the USB Network parameter correctly:

1. Press UTILITY twice and then hold SHIFT and press > (PAGE +)
to access the MIDI & USB page.
2. Set USB Network to NCM. If changed from RNDIS to NCM, restart

the instrument.

Using the Editor/Librarian

To start the multi/poly Editor/Librarian:

The Editor/Librarian has two modes: Editor and Librarian, selected using buttons in the upper right of the main

window.

Switch between modes as needed, noting that some menu commands may differ between modes.

Install the software and connect the multi/poly via USB, as described under “Installation” on page 4.
A USB connection is required.

« Start the multi/poly Editor/Librarian.

You can find the multi/poly Editor/Librarian application in the following locations, depending on the
operating system being used:
In MacOS, the multi/poly Editor/Librarian is installed into Applications/KORG/multi/poly.



In Windows, you can find the multi/poly Editor/Librarian under KORG/multi/poly in All Programs, the Start Menu,
etc.

Using the Editor/Librarian with two or more multi/polys
Important: Before connecting multiple multi/polys, make sure to set each instrument’s System ID to a different
number.

To set the multi/poly’s System ID:

1. Press the UTILITY button to go to the System Setup page.

If a different page appears at first, press UTILITY again.
2. Set the System ID parameter, at the bottom of the page, as desired.

The specific number isn’t important; just make sure that all connected multi/polys have different System IDs.
3. In the multi/poly Editor/Librarian, use the Devices menu to select the desired multi/poly.

Note that data cannot be copied directly from one multi/poly to another; instead, use Export to save the data

from the first multi/poly, and then Import to load the data into the second multi/poly.

Two modes: Editor and Librarian

The buttons in the upper right of the main window select whether you’re working with the Editor or the Librarian.
For the most part, you can simply switch between the two without thinking about it. It’'s important to note, however,
that some menu commands may be available only in one mode, and that undo is handled separately for each
mode.

Menu commands

In general, menu commands for file operations, such as importing, exporting, backing up, and restoring, are
available only when the Librarian is active. Similarly, menu commands for saving Performances are available only
when the Editor is active.

Undo/Redo

The multi/poly Editor/Librarian supports multiple levels of undo and redo for most actions, including importing data,
deleting, renaming, editing Set Lists, editing parameters, and so on. For instance, you could import a bundle file
containing a thousand objects, and then rename all of your Programs, and safely undo both actions in turn. Note
that restoring from a backup is not undoable. Undo/redo buffers are maintained separately for the Librarian and
Editor modes. You'll see this in the menu commands, whose names change based on the mode to either Librarian
Undo/Redo or Editor Undo/Redo, respectively.

FAQ

« Q: What should | do if my multi/poly software version is below 1.0.2?
A: Update the software using the Korg System Updater available on the Korg website.

« Q: How do | know if my computer meets the requirements for using the Editor/Librarian?
A: Ensure your Mac runs Mac OSX 10.12 through macOS 15 or Windows 10/11 for Windows PCs.

Introduction

About the multi/poly Editor/Librarian
The multi/poly Editor/Librarian lets you organize and edit data on a multi/poly connected to a Mac or Windows
computer via USB, and transfer sound data back and forth between the multi/poly and the computer.

For instance, you can:



« Edit Set Lists, Performances, Programs, Motion Sequences, Motion Sequence Lanes, and Scales

« See the progress of sequences and the results of modulation in real-time

« Import Wavetables in standard wavetable formats

« Back up and restore all of the multi/poly’s data

« Use Import and Export to transfer sounds to and from your computer, or from one multi/poly to another

« Edit metadata for user sounds (Set Lists, Performances, Programs, Wavetables, Motion Sequences, Motion
Sequence Lanes, and Scales), including the Name, Categories, and Collections (as shown on the multi/poly’s

display), as well as additional metadata including the Author and per-sound notes

Think of the Editor/Librarian as an external display for the multi/poly

Important: It's best to think of the Editor/Librarian as an external display for the multi/poly, instead of as a
separate program. Everything that you see in the Editor/Librarian’s main and Set List windows is actually stored
on the connected multi/poly.

When you make edits or import data with the Editor/Librarian, you are directly editing the data on the connected
multi/poly. The Editor/Librarian can export data to your computer (for backup, or for transferring to another
multi/poly), but it has no data of its own. This also means that the Editor/Librarian cannot be used “offline;” it only
functions when connected to a multi/poly.

Cautions
Do not disconnect your multi/poly from USB, or turn its power off, while the Editor/Librarian is running. Do not
operate your multi/poly while data is being transmitted.

Using the Editor

Basic use

Note: This manual describes how to use the Editor application. For details about how to use the multi/poly, and
how its functions and parameters work, please see the multi/poly Operation Guide.

Knobs and sliders

To edit knob values, drag vertically. To edit slider values, drag in the direction of the slider. Most knobs and sliders
can also be edited by hovering the cursor over the control, and then using the mouse wheel or dragging on the
trackpad. The exception is when the controls are in a scrolling list, such as the detailed effects edit panels. In
these lists, the mouse wheel and trackpad drag are used for scrolling, and so they are disabled for editing (to avoid
unintended changes). Double-click knobs and sliders to center them.

Graphic editing
Envelopes, LFOs, Key Zones, Key & Velocity Zones, Motion Sequence Lane Loop Start/End, and Master EQ can
be edited directly in their respective graphics. To do this:

1. Hover the cursor over the graphic to show a colored handle (either a dot or a line).

2. Drag the handle to edit the value.

For Envelopes, there are handles for Curve in the middle of the A/D/R segments.
For Key & Velocity Zones, option-drag to edit the fade zone.

Selecting sounds

multi/poly keeps track of sounds, and some individual sound elements, using a database. This includes
Performances, Programs, Motion Sequences, Motion Sequence Lanes, Effects and Kaoss Physics Presets,
Scales, Set Lists, and Wavetables.



In the Editor/Librarian, these appear as Selectors:

Selectors

Inc/Dec arrows ltem name “Edited” asterisk

Candy For Elly's Shoes * [Q)

Filtered List icon Save icon

This shows the currently selected item. Use the < and > arrows to step through them one by one, or click on the
name to bring up a browser window (see “Sound Browser” on page 8).

Important: the arrows step through the list of items according to the Sound Browser window’s sort order, and
filtered by the window’s Categories, Collections, and search text. Each individual selector remembers these
settings for as long as multi/poly is open and unless a new parent sound is selected (for example, the
Performance is the parent sound of the Program). If some items are hidden due to the selected Categories,
Collections, and search text, the Filtered List icon appears between the < and > arrows. To clear the filters and
show all items in the list, click the Filtered List icon. Alternatively, open the Sound Browser and adjust the filters as
desired. For more information, see “Sound Browser” on page 8.

For Performances only, if the Performance has been edited from its saved version, this is indicated by an asterisk
“*” to the right of the name. Press the Save icon to bring up the Save dialog; see “Saving Sounds,” below. Note
that this does not appear for items which can’t be edited within multi/poly, including Wavetables and Scales. Right-
click/control-click (macOS) on the name to bring up a contextual menu. For most items, this includes options for
saving and renaming. For Programs and Motion Sequences, it also includes Copy and Paste.

Sound Browser

Filters Panel Data List Metadata Columns

multipoly Editor Librarian

Search
Info panel

Categories

Collections

OK/
Cancel




Overview
The Sound Browser is used for selecting any type of sound data, such as Performances, Programs, Motion
Sequences, Motion Sequence Lanes, Wavetables, etc.

Filters Panel

The selections here help you narrow down the number of items in the Data List. Set the Search, Categories,
and/or Collections as desired. The Filters Panel can be resized by dragging its right edge, to show one, two, or
three columns of Categories and Collections.

Important: The Search, Categories, and Collections settings continue to affect data selection, even after the
Sound Browser is closed. Each individual sound selector remembers these settings for as long as multi/poly is
open and unless a new parent sound is selected (for example, the Performance is the parent sound of the
Program). For more information, see “Selectors” on page 7.

Data List

This shows the list of selectable sound data (Performances in the example above), as filtered by the Search,
Category, and Collection settings in the Filters Panel. Click on an item in the list to select it for auditioning, or use
the keyboard up/down arrows to browse through items one by one. Click in the list and type a few letters to select
sounds by name. Double-click (or press OK) to select and close the browser.

Metadata columns

For each item, the list shows the Name, Collection, Category, Author, and Notes, as well as whether or not the
item is locked factory data. You can drag the tops of the columns to re-arrange them, or to resize the columns.
Click on a column heading to sort; click again to reverse the sort order. The triangle icon shows which column is
selected for sorting, and the direction of the triangle (up or down) shows the sort order.

Info Panel
This panel lets you view the metadata for the selected items, including the Name, Collection, Categories 1 & 2,
Author, and Notes. The Inspector panel can be resized by dragging its left edge.

OK/Cancel
Press OK to confirm the selection and close the window, or Cancel to revert to the previous selection.

Search
Type into this field to filter the list by searching for text in any of the metadata fields. Click on the “X” to clear the
field.

Categories

Categories let you filter by the type of sound, such as basses, leads, bells, etc. Each sound can be assigned to
two Categories, and each data type—Performances, Programs, etc.—has its own list of Categories. Click on a
Category name to filter by that Category; click on the “X” to deselect all Categories. When searching by Category,
a sound will be shown if either of its Categories match the search criteria.

Collections

Collections let you filter sounds by group, such as factory sounds, expansion packs, or your own projects. Each
sound can be assigned to one Collection. Click on a Collection name to filter by that Collection; click on the “X” to
deselect all Collections.

Saving Sounds

The Performance, with its four Layers, is the main way of selecting, editing, and saving sounds. While you can
save Programs, Motion Sequences, Motion Sequence Lane Presets, and Kaoss Physics and Effects Presets, you
don’t have to do so: all data is contained in the Performance. Similarly, when you load any of these data types into
a Performance, a new copy of the data is created in the Performance. Any edits affect only the local copy inside



the Performance, and not the original data. This lets you edit freely without worrying about affecting other sounds.

To save a sound or preset:

1. Go to the Selector for the sound or preset. For more information, see “Selectors” on page 7.

2. Press the Save icon, or right-click/control-click (macQOS) on the name to open the contextual menu and select
the Save command.
The Save dialog will appear:
Save dialog

Save Performance

Name

Bay Area

Author

Category 2

None

Motes

3. Set the Name, Author, Collection, and Categories as desired.
You can also edit all of this metadata later, using the Librarian window.
Important: changing the name does not automatically make a new copy of the sound! Always use Save As
New when you want to make a copy.

4. Save the sound, using either Overwrite or Save As New.

To overwrite the existing sound, use Overwrite. To make a new copy and leave the existing sound unchanged, use
Save As New. Factory sounds may be write-protected, in which case only “Save As New” is available.

Renaming sounds

As described above, Performances store all of the data for their Programs, Motion Sequences, Motion Sequence
Lanes, and Kaoss Physics and Effects Presets. This also includes the names of those elements. Because of this,
you can rename any of these elements without saving them separately, as long as you then save the enclosing
Performance.

To do so:

1. Right-click/control-click (macOS) on the name and select the Rename... command in the contextual menu.
2. Select Rename.



3. Enter the new name, and press OK to confirm.
Names can be up to 24 characters long.

4. Make sure to save the Performance once you’re done.

Copy/Paste

You can use copy/paste with:

« Layers

« Programs

e LFOs

« Envelopes

« Filter & Amp Key Track

« Mod Processors

« Individual effects (Pre FX, Mod FX, Delay, Reverb, and Master EQ)
« Filter settings

« Arpeggiator settings

For example, you can copy from one LFO to another in the same Program, or copy Filter settings from one Layer
to another.

To use copy and paste with any of the above:

1. Right-click (or control-click on MacOS) on the title of the section that you'd like to copy, such as Pitch LFO,
Arpeggiator, or Mod Processor 2.
A contextual menu will appear.

2. Select Copy from the contextual menu.

3. Right-click (or control-click on MacOS) on the title of the section to which you’d like to Paste. Note that this has
to be the same type as the copy source; for instance, you can’t copy an LFO to an Envelope.

4. Select Paste from the contextual menu.

Copy/Paste for Motion Sequence Steps

Motion Sequence Steps support Copy and Paste, as well as Cut, Insert Before, Insert After, and Delete. Shift-click
to select a range of Steps, or select multiple non-continuous items by holding down the command key on MacOS,
or the Ctrl key in Windows. Once you've selected the desired step(s), right-click (or control-click on MacOS) to
bring up the contextual menu and choose the desired copy/paste operation.

If you have cut or copied multiple steps, and then select a range of steps as the Paste destination, the
following will happen:

« If a single step is selected, the steps will be pasted starting at that step, and then replace as many steps as
necessary following that step.

« If you've selected exactly the same number of steps as are on the clipboard, even if they are discontiguous,
Paste will replace only those selected steps.

« If you've selected fewer steps than are on the clipboard, even if they are discontiguous, Paste will replace the

selected steps, and then replace as many steps as necessary following the last selected step.



« If you've selected more steps than are on the clipboard, Paste will replace the selected steps with a loop of the

clip-board, stopping at the last selected step.

If you select a range of steps as the Insert Before or Insert After destination, only the first or last step matters.
Insert Before refers to the first selected step, and Insert After refers to the last selected step.

Motion Sequence editing

Timing

Timing Lane

Motion Sequence
Inspector

Motion Sequence Inspector
This area shows details for the currently selected Lane or Step.
To edit Lane parameters, click on the Lane’s title. To edit Step parameters, click on a Step.

Changing the number of displayed steps
Use the 16/32/64 step buttons to adjust the viewable range of the display, to show 16, 32, or 64 steps,
respectively.

Editing Start, End, and Loop steps
The triangles above the Steps show the Loop Start (green) and Loop End (red). To edit, just click and drag on the
triangles.

Editing values on the Step graphics

For the Pitch and Step Sequence lanes, as well as the Timing Lane when Tempo is off, drag on Steps in the
graphic to edit the Transpose, Step value, or Duration, respectively. For the Shape lane, as well as the Timing
Lane when Tempo is on, click and hold to bring up a popup menu to select the Shape or note value, respectively.

Solo Step
Step solo mode makes the Lane temporarily loop on the selected Step, for auditioning shapes, troubleshooting,
etc.

To enter Step Solo mode:

1. Right-click or control-click (macOS) on a Step to bring up the contextual menu.

2. Select the Solo Step command.

The Step will be marked with a yellow outline. The Motion Sequence will play as if that Lane was set to loop on the
selected Step. Other Lanes will continue to play normally. If you select other Steps in the current Lane, solo will
follow the selected Step. To exit Step Solo mode, bring up the contextual menu and un-select Solo Step.

Only one Lane at a time can be in Step Solo mode. If you enter Step Solo mode for a second Lane, the first Lane’s
Step Solo mode is turned off automatically. Changing to a different Layer also turns off Step Solo mode.



Modulation

The Editor shows real-time modulated values as orange dots on knobs and sliders. If a parameter is shown only
as a text or numeric box, and it is modulated, the text is shown in orange.

Modulation inspector
The modulation inspector in the upper right shows the modulation routings, if any, for the selected parameter
(marked by an orange box). You can also add new modulations or delete existing ones.

Drag and drop modulation routings

To create a modulation routing using drag and drop:

1. Click on the name of any of the following: the Mod or Pitch wheel, Mod Knobs, Kaoss Physics, Kaoss Physics,
Envelopes, LFOs, Key Tracks, Seq A/B/C/D, or Mod Processors.
For the Mod Knobs and wheels in particular, make sure to click on the name, and not the control or value
display!

2. Drag to a modulation destination.

Modulating one mod source with another
You can also drag-and-drop to modulate one mod source with another.

To create this sort of routing via drag-and-drop:

1. Click on the name of the mod source, as above.

2. Drag and hold over the tab for the desired modulation destination.
For example, to modulate the Pitch LFO, hold over the LFOs tab.
After a moment, the tab will open.

3. Once the tab opens and displays its contents, drag to the desired destination.

Fixed modulation routings

Fixed modulation routings, such as Amp LFO to Amp Level, are shown in the Mod Inspector. These routings are
marked by a lock icon, and differ from user-created modulation routings in several ways: they cannot be deleted,
the mod source cannot be changed, and there is no second modulation source.

Effects

Using the Editor, you can edit internal effects parameters and save Effects Presets. Press the EDIT button next to
the effect name to show the full list of effects parameters.
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Modulation of internal parameters is allowed only from the FX Edit 1/2/3 knobs. To modulate effects from other
sources, such as the Mod Wheel or the Mod Knobs, assign the internal parameter to one of the FX Edit knobs, and
then modulate the FX Edit knob from the desired source.

Using the Librarian

Import and export

Import and export let you transfer data between the multi/poly and the computer. This lets you import new sounds,
transfer sounds from one multi/poly to another, or back up and restore specific data. For backing up the entire
contents of the multi/poly, see “Backup and restore” on page 16.

Important: make sure to read “Think of the Editor/Librarian as an external display for the multi/poly” on page 3.
Importing data

To import data from your computer to the multi/poly:

1. In the File menu, select the Import... command.
A standard file open dialog will appear.
2. Select the multi/poly file(s) to import.
You can select and import multiple files at once.
3. Press the Open button.
The data in the file(s) will be imported into the multi/poly. A message will appear to confirm the import, including

information about which files have been added.

Data conflicts

If some of the imported data appears to be different or updated versions of the internal data, a dialog will appear
with the text:

“A different or changed item already exists in the database for <item name>”



The dialog offers several options:

« Cancel: the item will not be imported.
« Overwrite: the item will be imported, replacing the version in the multi/poly.
« Make Unique: the item will be imported, and its UUID (see “UUIDs” on page 14) will be changed so that it does

not conflict with the version already in the multi/poly.

Apply to All: the choice of Cancel, Overwrite, and Make Unique will be applied to all conflicting files in the
Import.

If a Set List is imported, and some of its constituent Performances were made unique, then the Set List is edited to
point to the new Performances.

UUIDs

The multi/poly uses a database to keep sounds organized. Internally, sounds are identified not by their names, but
rather by a unique tag attached to the file, called a UUID (“Universally Unique Identifier”). This means that even if
a sound’s name has been changed, the system still knows it's the same sound. When you write a sound from the
multi/poly front panel, “Overwrite” keeps the UUID the same, and “Save As New” creates a new UUID. When you
import data, the UUIDs in the sounds to be imported are compared with those already in the database. If a sound
has the same UUID, but its contents are different, you'll see the dialog described under “Data conflicts” on

page 14.

Exporting data
When exporting two or more pieces of data, you can either save them as separate files or as a single Bundle file.

Exporting as separate files

To export data from the multi/poly to your computer as separate files on disk:

1. In the Main Window, select the data that you’d like to export. For more information, see “List and selection” on
page 22.

2. In the File menu, select the Export... command.
A standard file open dialog will appear.

3. Navigate to the location to save the files.

4. Press Open to select the current directory and save the files.

Exporting as a bundle

To export multiple pieces of data from the multi/poly to your computer as a bundle:

1. In the Main Window, select the data that you’d like to export.

2. In the File menu, select the Export Bundle... command.

3. Navigate to the location to save the bundle, and enter a name for the file.
4. Press Save to save the bundle file.

Exporting all user data

To export all of your custom data as a single bundle file, without saving the write-protected factory
sounds:



1. In the menu, select the Export Bundle of All User Sounds... command.
2. Navigate to the location to save the bundle, and enter a name for the file.

3. Press Save to save the bundle file.

This exports a bundle of all non-write-protected data, for backing up or transferring all of your custom sounds at
once.

Importing and exporting Set Lists

Set Lists refer to up to 64 Performances. When you export a Set List, both the Set List and its referenced
Performances are saved together. This makes it easy to transfer groups of sounds between two or more
multi/polys.

File Types
The multi/poly Editor/Librarian uses the file types below.

Type Extension Contents
Performance mpperf
Program mpprog
Wavetable korgwavetable
Kaoss Physics mpkphysics
Scale korgscale
Motion Sequence mpmotionseq
A single item of the specified type.
Master Lane mpmasterin
Timing Lane mptimingIn
Pitch Lane mppitchin
Shape Lane mpshapeln
Step Seq Lane mpstepseqin
Effect mpeffect
Set List mpsetlist One Set List and all of its referenced Performances
Bundle mpbundle Multiple items of any type.
Backup mpbackup The entire contents of the multi/poly.

Importing Wavetables
The modwave and multi/poly both use “.korgwavetable” files, so you can easily share wavetables between the two
instruments. You can also import Wavetables in two standard formats. Both formats are specially-prepared .wav



files, which contain up to 64 individual waveforms laid out end-to-end, one immediately after the other. Each of the
waveforms must be exactly the same length.

The two supported formats are:

« 32-bit floating point data, with waveforms exactly 2048 samples long (commonly used by software synthesizers,
such as Serum)

« 16-bit linear data, with waveforms exactly 256 samples long (commonly used by modular synth hardware)

The main difference between the two formats is that 2048-sample waveforms allow three more octaves of high
harmonics. In practice, this means that bass notes can be brighter in timbre.

Important: .wav files must be in one of the two supported wavetable formats, as described above. Normal audio
files, such as recordings of instruments, will not be automatically converted into wavetables.

Importing Wavetables with more than 64 waveforms

The multi/poly, like many other wavetable synths, crossfades between waveforms in real-time. Some popular
wavetable software uses a different approach; instead of crossfading, they create a series of intermediate
waveforms and then just switch between them. If the differences between the intermediate waveforms are small, it
sounds close enough to a crossfade. To transition between two waveforms, they might create a Wavetable with
the first waveform at the start, 254 intermediate waveforms, and then finally the second waveform at the end.

To transition this smoothly between 64 different waveforms, they would need to create over sixteen thousand
intermediate tables! The multi/poly, on the other hand, needs only the 64 original waveforms to create a
completely smooth, stepless crossfade. This is kept in mind when importing wavetables. If a 32-bit/2048-sample
wavetable has more than 64 waveforms, the multi/poly will assume that it's a generated crossfade and drop some
of the intermediate waveforms to create a 64-waveform version.

Creating and editing Wavetables

For creating and editing your own Wavetables, we suggest using WaveEdit. WaveEdit is free, and available for
MacOS, Windows, and Linux. See www.korg.com for a link to a version of WaveEdit which is optimized
specifically for the modwave and multi/poly, and can create Wavetables in the 32-bit/2048-sample format.

The Editor/Librarian can export multi/poly-format Wavetables, just like Performances, Programs, etc. However,
exported Wavetables cannot be edited.

Instead, to make edits to previously imported custom Wavetables:

1. Open the source file in your Wavetable editing application.

2. Edit the Wavetable as desired.

3. Save the results to a new .wav file, using the same name as the Wavetable in the multi/poly’s database. Using
the same name is important; see “Duplicates and file names,” below.

4. In the multi/poly Editor/Librarian, Import the .wav file as a Wavetable.

5. When prompted, choose to replace the existing Wavetable.

This will automatically update any existing sounds to use the new version.

Duplicates and file names

.wav-format Wavetables don’t have multi/poly UUIDs until after they’ve been imported into the database (see
“UUIDs” on page 14). So, to check for duplicate files, the multi/poly uses the name of the .wav file on disk. If you
import a .wav-format Wavetable file, and it has the same name as a Wavetable already in the multi/poly’s
database, the Editor/Librarian will ask if you want to overwrite the existing Wavetable, or make a new, unique
Wavetable instead.


http://www.korg.com

Backup and restore

Backing up all data

. In the File menu, select the Backup... command.

The Main Window will change to show the Backup window.

2. Enter a brief descriptive note.

3. Press Start to begin the backup, or Cancel to return to the Main Window.

A progress bar shows the status of the backup, and a message appears when the backup is complete.

. Press the Done button to return to the Main Window.

Restoring data

Important: Restoring from a backup will delete all of the data currently in the multi/poly. If a subset of the data
types is selected during the restore, only the data of the selected types will be deleted.

. In the File menu, select the Restore... command.

A standard file open dialog will appear.

Select the multi/poly backup file to use for the restore.

The Main Window will change to show the restore dialog. This shows the text note stored with the file, and
includes a series of check-boxes to select the types of data which will be restored. By default, all data types are
selected except for Calibration Data.

Important: Only select Calibration Data when restoring to the identical physical instrument which created the

backup. Otherwise, leave it un-checked.

3. If desired, select the types of data to restore.

4. Press Start to begin the restore, or Cancel to return to the Main Window.

A progress bar shows the status of the restore, and a message appears when the restore is complete.

Tip: Merging data

If you want to merge your current state with a previous state, use Export and Import instead. If you have a backup
file and want to merge it with your current state, first Export all data, then restore from the backup, and then re-
Import the data.

Editing Set Lists

With the Editor/Librarian, you can:

Duplicate Set Lists
Add Performances to Set Lists via drag-and-drop
Re-arrange, cut, copy, and delete the Slots in a Set List

Copy from one Set List to another

Duplicating Set Lists

To duplicate a Set List:



1. In the Main Window, select one or more Set Lists.
It may help to select the Set Lists tab first, so that only Set Lists are shown. For more information, see “Main
Window” on page 21.

2. In the Edit menu, select the Duplicate command.

You can also right-click on the Set List in the Main Window and use the contextual menu.
The selected Set List(s) will be duplicated, with a number appended to their name.

Adding Performances to a Set List

To add Performances to a Set List:

1. Open a Set List window.
With the default Preferences settings, you can open the window by double-clicking on a Set List in the Main
Window. For more information, see “Preferences” on page 25.

2. Select one or more Performances in the Main Window.

3. Click and hold on a selected Performance, and drag it over a Slot in the Set List window.
The Performance will be pasted over the Slot. If you're dragging multiple Performances, they will be pasted over

the Slot and immediately subsequent Slots, as necessary.

Re-arranging Slots in a Set List, or copying from one Set List to another

You can re-arrange the Slots in a Set List, such as using cut, copy, paste, and insert, using three different
methods:

o Commands in the Edit menu
« Commands in the pop-up contextual menu (right-click, or control-click on MacOS)

« Drag-and-drop

You can open multiple Set List windows at once. If one of the windows shows the Set List currently selected on
the multi/poly, the note “(Active)” appears after its name in the title bar.

Using commands in the Edit menu or contextual menu

To re-arrange Slots using the Edit menu:

1. Select the Slots that you’d like to copy, cut, or delete.
You can select two or more non-continuous Slots using command-click on MacQOS, or Citrl-click in Windows.
Alternatively, select a continuous range of Slots by using Shift-click.

2. Select the Cut, Cut and Shift Slots, Copy, or Delete command, as desired.
You can either select the commands from the Edit menu, or bring up the contextual menu by right-
clicking/control-clicking on one of the selected Slots. For details on how these work, especially Cut and Shift
Slots, see “Edit menu” on page 26.
If you delete a Slot, its contents are replaced by the Init Performance.
If using Paste or Insert Before, continue:

3. Select the destination Slot.



Important: if multiple Slots are selected, only the lowest-numbered selection affects the Paste or Insert Before
operation; other selections are ignored. For more information, see “Paste” on page 26 and “Insert Before” on
page 27.

4. Select the Paste or Insert Before command, as desired.

Using drag-and-drop

To re-arrange Slots using drag-and-drop:

1. Select the Slots that you'd like to copy or cut.

2. Click and drag on top of a Slot to Paste, or to the space between Slots to Insert Before.
The effect on the original Slots depends on whether or not you hold the Option key (MacOS) or Alt key
(Windows), and whether you're dragging within a single Set List or from one Set List to another, as shown in

the table below.

Destination Drag action Edit action Affect on Original Slots
On top of a Slot Paste Changed to Init Performance
/OArllt top of a Slot, holding Option Paste Remain unchanged
Same Set List
Between Slots Insert Before | Removed, as with Cut and Shift Slots

Between Slots, holding Option/ Remain, shifted down with the rest of the
Alt Insert Before Slots

Different Set Lis | ON top of a Slot Paste

i Original Slots always remain unchanged

Between Slots Insert Before

Note that dragging to a different Set List always leaves the original Slots intact; option-drag is not required.

Editing Scales

To edit Scales:

1. Go to the Librarian window.

2. Set FILTERS (at the top of the left panel) to Scales.
The main section of the window will change to show the installed Scales.

3. Double-click on an unlocked Scale, or right-click on an unlocked Scale and select Open Scale Editor from the
contextual menu.
Only unlocked user Scales can be edited. To create an editable version of a locked, factory scale, right-click on
the Scale and select Duplicate from the contextual menu.

4. Edit the scale as desired; see “Scale settings,” below.

5. Press Save to save the edited scale, or Cancel to exit and discard the changes.

Important: Save always overwrites the existing Scale data, even if you change the name. To create a new Scale,
use the Duplicate command first, and then edit the duplicate Scale.



Scales are saved with the “korgscale” extension, and can be shared between the wavestate, modwave, and
multi/poly.

Edit Scale

Edit Scale
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Scale settings

Scale Name
[Text]
This lets you edit the name of the Scale.

Important: Save always overwrites the existing Scale data, even if you change the name!

Type
[Octave Scale, Octave Scale, A=Master Tune, 128 Note Scale]

There are three supported scale types:

Octave Scale is a standard 12-note scale which repeats every octave.

Octave Scale, A=Master Tune is similar to the above, except that the Scale is automatically adjusted so that the
pitch for A matches the Master Tune setting (e.g., A=440Hz), regardless of the Scale Key.

128 Note Scale allows separate tuning of each MIDI note, for Scales which don’t repeat on octave boundaries.

Cents
[-100...+100]
Each note can be detuned by up to 100 cents, flat or sharp.

Semitones

[-127...+127]

The Semitones parameter lets you detune a note by up to the entire MIDI range. As a simple example, to make the
C key play a D pitch, set Semitones to +2. This is useful for scales which do not repeat on octave boundaries, or
for repeated notes within an octave scale.



Editing Global UTILITY Settings

Overview
The Editor/Librarian can edit most of the settings found under the UTILITY button. (The USB Network setting is an
exception.)

To do so:

1. Select the Global UTILITY Settings... command in the Edit menu.
The Global UTILITY Settings window will open, as shown below.
2. Edit the settings as desired.
For details about the settings, please see the multi/poly Owner’s Manual.

3. When you’re done, click the close button (“X”) in the top right corner.

Important: Edits in this window take place immediately; there is no Cancel button. You can, however, use Reset
All To Defaults if necessary.

Restoring Defaults

Reset All To Defaults...

This button is in the lower left corner of the window. It lets you restore all of the settings under the UTILITY button,
such as the MIDI CC assignments, to their factory defaults. Pressing the button brings up a confirmation dialog.
Press OK to restore default settings, or Cancel to exit.

Global UTILITY Settings

Global UTILITY Settings

Set List < » Taste of Multi/Poly Global Scale Use Global Scale
Select at Power On Last Used Set List A1 el Active ¢ Equal Temperament

Active < > Equal Temperament
Master Tune

CC Assign

Within Scale

Local Control

111-119

3 (Normal) Auto Power Off

Channel+Poly

Pre-MIDI Post-MIDI Knob Mode Jump

SST Hold Time CMT ID

Reset All To Defaults... Memory Protect

Windows

This section provides a brief explanation of the multi/poly Editor/Librarian’s screens and their functions.

Main Window
This is the central window for the multi/poly Editor/Librarian. It has two basic states, controlled by the buttons at



the top right: Editor and Librarian.

Librarian
This shows lists of all the data on the connected multi/poly.

Data Type Data List Metadata Columns Editor/Librarian select

Filters Panel
™~ ° multipaly Editor Librarian

\ multi/poly

Search

Info Pane
Categories

Collections

Current Performance

This shows the Performance currently active on the connected multi/poly. This will update if you change the
Performance on the multi/poly, or if you select a Performance using the Editor/Librarian. For more information, see
“Performance Selection” on page 25.

LIBRARIAN and EDITOR buttons
The buttons in the upper right of the main window select whether you're working with the Editor or the Librarian.

Search Field
This filters the list by searching for text in any of the metadata fields.

Lock icons: factory data is write-protected

All of the data shipped from the factory is write-protected, including Performances, Programs, Effects presets, and
so on. This is shown by the lock icons in the list and at the top of the Inspector panel. Factory sounds can’t be
deleted, and their original versions can’t be changed, including metadata such as name, author etc. However, you
can duplicate them and then edit however you’d like.

Data Type menu

The list can show the Performances, Programs, Wavetables, Kaoss Physics presets, Motion Sequences, Motion
Sequence Lane presets, Scales, Effects presets, and Set Lists on the connected multi/poly. This menu chooses
which type(s) of data are shown in the list. All Data shows all types of data at once.

Metadata columns

For each item, the list shows the Type, Name, Collection, Category, Author, Notes, and Created and Modified
dates, as well as whether or not the item is locked factory data. You can drag the top of the columns to re-arrange
them, or to resize the columns. Click on a column heading to sort; click again to reverse the sort order. The triangle



icon shows which column is selected for sorting, and the direction of the triangle (up or down) shows the sort
order.

Info Panel

This panel lets you view and edit the metadata for the selected items, including the Name, Collection, Categories 1
& 2, Author, and Notes. If more than one item is selected, and the items have different settings for a metadata field
(such as the name or category), the field shows the note “<Multiple Values.>” If the lock icon is shown, the
selection includes factory data, and the fields cannot be edited. You can, however, copy text to paste elsewhere.
The Info panel can be resized by dragging its left edge.

Categories

Categories let you filter by the type of sound, such as basses, leads, bells, etc. Each sound can be assigned to
two Categories, and each data type—Performances, Programs, etc.—has its own list of Categories. Click on a
Category name to filter by that Category; click on the “X” to de-select all Categories. When searching by Category,
a sound will be shown if either of its Categories match the search criteria.

Collections

Categories let you filter sounds by group, such as factory sounds, expansion packs, or your own projects. Each
sound can be assigned to one Collection. Click on a Collection name to filter by that Collection; click on the “X” to
de-select all Collections.

List and selection

This list shows the contents of the connected multi/poly, as filtered by the data type tabs and search field. Click on
an item in the list to select it. Selecting Performances and Set Lists can, optionally, also select them on the
connected multi/poly. For more information, see “Preferences” on page 25. Select multiple non-continuous items
by holding down the command key on MacQOS, or the Ctrl key in Windows. You can also select a range of items by
using Shift.

Editor
This shows the parameters for the current Performance.

Editor/Librarian select

Current Performance Modulation Inspector Randomize

® multipoly Editor Librarian \

multi/poly .

Layers A/B/C/D ) Lare

Keyboard,

Mod Sources,
and Effects tabs

Motion Sequence
Editor

Motion Sequence
Inspector

Current Performance
This shows the Performance currently active on the connected multi/poly. This will update if you change the



Performance on the multi/poly, or if you select a Performance using the Editor/Librarian. For more information, see
“Performance Selection” on page 25.

Modulation Inspector
This shows the modulation routings for the selected parameter. You can add or delete routings from the list, and
add Intensity Modulation to existing modulation routings.

LIBRARIAN and EDITOR buttons
The buttons in the upper right of the main window select whether you're working with the Editor or the Librarian.

Layers A-D
These tabs select which of the Layers will be shown, and whether they are on (button lit green) or off.

Keyboard, Mod Sources, and Effects tabs

These let you edit key and velocity zones, Arpeggiator, Kaoss Physics, LFOs, Envelopes, Key Tracking, Mod
Processors, Motion Sequencer, and effects. You can drag from the mod sources here to modulate parameters in
the main part of the screen, or even other modulation parameters; see “Drag and drop modulation routings” on
page 13.

Motion Sequence Editor
This area lets you select and edit the Motion Sequence Steps, and view the Motion Sequence in real-time. It
appears when the Motion Sequencer tab is selected.

Motion Sequence Inspector
This area shows the parameters for the selected Motion Sequence Lane or Motion Sequence Step.

Set List window

This window shows all 64 Slots of a Set List. You can open multiple Set List windows at once. If one of the
windows shows the Set List currently selected on the multi/poly, the note “(Active)” appears after its name in the
title bar.



Slots selected for cut/copy/paste are outlined in blue
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The name of the Set List is shown both in the window’s title bar, and in an editable field at the top of the window.
As with the rest of the Editor/Librarian, any edits to Set Lists take effect immediately. Selected Slots are shown
with a blue outline. You can select multiple non-continuous Slots by holding down the command key on MacQOS, or
the Ctrl key in Windows. Alternatively, select a range of Slots by using Shift. For detailed instructions about using
this window, see “Editing Set Lists” on page 17.

Menus

Application menu (MacOS only)

Preferences
Displays the Preferences dialog box, which contains two parameters: Performance Selection and Set List
selection.

Performance Selection

Double-click in list selects on synth: Double-clicking a Performance in the Main Window selects the Performance
on the multi/poly. Single-click allows you to view and edit a Performance’s metadata without affecting the current
sound on the multi/poly. Select in list also selects on synth: Selecting a Performance in the Main Window also
selects the Performance on the multi/poly. Use menu to select on synth: No actions in the Main Window will
automatically select sounds on the multi/poly. Only the Edit menu’s Select On Synth command will do so.



Set List Selection

Double-click in list opens editor: Double-clicking a Set List in the Main Window opens a Set List window for that
Set List. No change is made to the current Set List selection on the multi/poly. Double-click in list selects on synth
and opens editor: Double-clicking a Set List in the Main Window both opens a Set List window for that Set List,
and selects that Set List on the multi/poly. Use menu to edit or select on synth: No actions in the Main Window will
automatically either open a Set List window, or select Set Lists on the multi/poly. Only the Edit menu’s Open Editor
and Select On Synth commands will do so.

About
This displays the software version of the multi/poly Editor/Librarian.

File menu

Important: Many of these commands, including Import, Export, Export Bundle, Backup, and Restore, are
available only when the Librarian window is displayed. If the Editor is displayed instead, these commands will be
grayed out.

Save Performance...
This brings up a dialog to overwrite the current Performance.

Save As New Performance...
This brings up a dialog to save the current Performance as a new item, leaving the previous version intact.

Import...
Imports one or more files from disk. The data will be directly imported into the multi/poly. For more information, see
“Importing data” on page 14.

Export...
Exports the items selected in the Main Window (not a Set List window, if any are open) to individual files on disk.
For more information, see “Exporting data” on page 14.

Export Bundle...
This command is available if multiple items are selected. It exports all the selected items to a single file on disk.
This is convenient for distributing a set of sounds, for example.

Export Bundle of All User Sounds...
This is available only when the Librarian is active. It exports a bundle of all non-write-protected data, for backing up
or transferring all of your custom sounds at once.

Import WAV as Wavetable...
Imports one or more wav files as Wavetables. The data will be directly imported into the multi/poly. For more
information, see “Importing Wavetables” on page 15.

Backup...
Backs up the entire contents of the multi/poly, including write-protected factory data, to a file on disk. For more
information, see “Backing up all data” on page 16.

Restore...
Deletes the entire contents of the multi/poly, including write-protected factory data, and then restores all data from
a file on disk. For more information, see “Restoring data” on page 16.

Edit menu



Note: many operations apply only when editing Set Lists, and will be disabled otherwise. These include Cut, Cut
and Shift Slots, Copy, Paste, and Insert Before.

Undo

Returns to the state prior to the previous operation. This applies to any edits made in the Editor windows — for
instance, editing synthesis parameters or effects, creating modulation routings, and so on. In the Librarian, it
applies to edits of metadata (such as names and categories), Set List edits, creation of new Set Lists, object
duplication and deletion, and data Import. Note that restoring from a backup is not undoable. The system supports
multiple undos, so that you can step backwards and forwards through a series of actions. Undo/redo history is
maintained separately for the Librarian and Edit modes. The names of the undo/redo commands change to reflect
this; for example, “Editor Undo: Value Change: Cutoff ” or “Librarian Undo: Update Name.”

Redo
Returns to the state prior to executing the “Undo” command. The system supports multiple redos, so that you can
step backwards and forwards through a series of actions.

Delete

This removes the selected data. When used with Set List Slots, the Slots are changed to use the Init Performance.
Note that factory data may not be deleted or changed. Also, there must always be at least one Set List; if there is
only a single Set List in the system, it cannot be deleted.

Cut
This applies to Set List editing only. It cuts the selected Set List Slot(s), placing them on the clipboard, and
changes them to use the Init Performance.

Cut and Shift Slots
This applies to Set List editing only. It cuts the selected Set List Slot(s), and shifts all other Slots to fill in the gap.
The newly empty Slots at the end of the Set List will be filled by the Init Performance.

Copy
This applies to Set List editing only. It copies the selected Set List Slot(s), and places their data on the clipboard for
use in Paste or Insert Before.

Paste

This applies to Set List editing only. It replaces the selected Set List Slot, and potentially subsequent Slots, with
the data on the clipboard.

If multiple Slots are selected, only the lowest-numbered selection affects the Paste operation; other selections are
ignored.

Important: if the clipboard contains multiple Slots, Paste will start with the first selected Slot and then replace as
many Slots as necessary, regardless of how many other Slots are selected. For example, if there are four Slots on
the clipboard, and you select Slots A3 and A7 and then Paste, Slots A3, A4, A5, and A6 will be replaced with the
data from the clipboard.

Insert Before

This applies to Set List editing only. It inserts the data on the clipboard into the Set List before the selected Set List
Slot, and shifts subsequent Slots to make room. Slots at the end of the Set List will be “pushed off the end” and
removed. As with Paste, if multiple Slots are selected, only the lowest-numbered selection affects the Insert Before
operation; other selections are ignored.

Duplicate
In the Main Window, this duplicates the selected item.

Select All



This selects all items shown in the front-most window, including either the main or Set List windows.

Deselect All
This clears any current selections in the front-most window.

New Set List
This creates a new Set List, with all Slots set to the Init Performance. It is available from the Main Window, when
showing either All Data or Set Lists.

Open Set List Editor
When a Set List is selected in the Main Window, this opens a Set List window for that Set List. If multiple Set Lists
are selected, it opens widows for each of them.

Select On Synth

When a Performance or Set List is selected in the Main Window, this selects the item on the multi/poly. When an
active Set List window is open, this selects the current Set List Slot. When an inactive Set List window is open, this
selects the Performance assigned to the Set List Slot.

Open Set List Editor
When a Set List is selected in the Main Window, this opens a Set List window for that Set List. If multiple Set Lists
are selected, it opens widows for each of them.

Global UTILITY Settings...
This opens the Global UTILITY Settings window, to edit controller settings, MIDI settings, etc. For more
information, see “Editing Global UTILITY Settings” on page 20.

Verify Sound Data...
This checks the sound data on the instrument, and corrects any issues if necessary. It is only required (and only
has any effect!) in rare circumstances. Use this only if recommended by Korg support personnel.

Preferences (Windows only)
This shows the Preferences dialog. For more information, see “Preferences” on page 25.

View menu

Show Librarian
This switches the main window to show the Librarian. It's the same as pressing the Librarian button in the upper
right of the window.

Show Editor
This switches the main window to show the Editor. It's the same as pressing the Editor button in the upper right of
the window.

Zoom 50%...150%
This scales the entire Editor/Librarian window to be smaller or larger.

Devices menu

This menu shows the all of the multi/polys connected to the computer, and selects one of them to be used by the
Editor/Librarian. If there are multiple multi/polys, you can change between them at any time. Note: when you
change devices, the undo history will be cleared, and so undo/redo will no longer be available for past actions.
Data cannot be copied directly from one multi/poly to another; instead, use Export to save the data from the first
multi/poly, and then Import to load the data into the second multi/poly.



Important: Before connecting multiple multi/polys, make sure to set each instrument’s System ID to a different
number. For more information, see “Using the Editor/Librarian with two or more multi/polys” on page 6.

Windows menu
This menu shows all of the Editor/Librarian’s open windows. Select a window’s hame to bring it to the front.

Main Window
The Main Window is always shown at the top of the menu. Note that closing the Main Window will quit the
Editor/Librarian application.

Set List Windows
Open Set List windows, if any, are listed below the Main Window.

Close All Set List Windows
This command closes all open Set List windows.

Close Current Set List Window
This command closes the front-most Set List window.

Help menu

Search field (MacOS only)
This brings up the standard search menu for system help, including the application’s menu commands.

About multi/poly Editor/Librarian (Windows only)
This displays the software version of the multi/poly Editor/Librarian.

Check for Updates...
This checks to see if a new version is available. If so, a dialog appears with a download link.

Open Online Manual
This opens the latest version of the PDF manual in your browser.

Troubleshooting

Software won’t start up
Make sure that your computer meets the operating requirements
See “Operating requirements” on page 3.

Check whether other applications might be running
If other applications are running, it is possible that they might somehow interfere with the multi/poly
Editor/Librarian. As a troubleshooting step, quit the other applications.

Can’t connect to the multi/poly

Make sure that the multi/poly is connected via USB
The Editor/Librarian requires USB, and cannot communicate with the multi/poly over 5-pin DIN MIDI.

Try connecting the multi/poly directly to your computer, without a USB hub
Faulty hubs may interfere with the connection. Hubs must support USB 2.0 or better.

Try a different USB cable



A faulty cable might interfere with the connection.

Confirm that the multi/poly is running software version 1.0.2 or later
To check the software version number, press UTILITY and then SHIFT + < (PAGE -).

Make sure that the multi/poly has been detected by the connected computer

« Windows: open the Device Manager (see the instructions under “Windows” on page 5) and check the “Other
Devices” tab. If the multi/poly does not appear, repeat the NCM or RNDIS configuration procedure.
« Mac OS: open the System Preferences application, in the Applications folder. Go to the Network panel, and

check the list of networks and network devices on the left of the window.

Make sure that the required network ports are not blocked by a software firewall

When communicating with the multi/poly over USB, the Editor/Librarian uses TCP ports 50000 and 50001, and
Bonjour uses UDP port 5353. These won'’t be affected by an external firewall in a separate server or router, but
can be blocked by a software firewall running on the same computer.

Disable VPN software
Some users have reported that VPN software may interfere with communication to the multi/poly.

Windows: confirm that Bonjour is running
Open Services, find Bonjour Service in the list, and confirm that its Status is Running and Startup Type is set to
Automatic.

Confirm that you have the latest version of the Editor/Librarian
You can download the latest version from the Korg website (http:/www.korg.com/ ).

Try restarting your computer
In some cases, the multi/poly may not be immediately recognized after installation. If this occurs, simply restart
your computer.

Windows: check Device Manager

Open Device Manager, and find the multi/poly. If it is not shown under Other devices or Network adapters, check
under Universal Serial Bus controllers. If there is a new device named “USB Composite Device,” marked by the
“warning” icon (an exclamation point in a yellow triangle), double-click on that entry to bring up the Properties
dialog. If the General tab shows the device status as “unable to start” with a code of -10, this may be the problem.
To resolve this, right-click on the USB Composite Device entry to bring up a contextual menu, and select the
Uninstall Device option. Press the Uninstall button on the dialog which appears. After this, disconnect the USB
cable from the multi/poly, wait briefly, and then connect it again. A new CDC NCM (or RNDIS) device should
appeatr, again with a warning icon; this indicates that the multi/poly has been detected properly. Finally, re-do the
Editor/Librarian installation, as described under “Windows” on page 5.

")

Bonjour

Apple, Mac and the Mac logo, Bonjour, the Bonjour logo, and the Bonjour symbol are trademarks of Apple Inc.,
registered in the U.S. and other countries. Windows 10 and Windows 11 are trademarks of Microsoft Corporation
in the US and other countries. All product names and company names are the trademarks or registered
trademarks of their respective owners. Specifications and appearance are subject to change without notice for
improvement.
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